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This tutorial will show the reader how to easily lay out the basic elements of reports, research papers, 
academic papers, essays, and so on, in Microsoft Word using the title page, table of contents, and bibliography 
features available in versions 2007 and 2010. 
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Introduction 
The purpose of this tutorial is to instruct the reader step-by-step how to lay out the basic elements of reports, 

research papers, academic papers, essays, and so on, using very useful features of Microsoft Word.  Students 

of higher education in particular, are finding themselves having to write numerous technical papers and 

tackling the correct way to format resources using a particular style alone can be quite challenging.  Microsoft 

Word’s “Reference” features make this task and others easier than they have ever been before.  Even though 

Microsoft Word’s “Reference” features came out in version 2007, there are still many who don’t know they 

exist, as well as those that do, but do not know how to use them.  My intent is to change that. 

Basic Elements  
While most types of writing assignments should include and introduction, body content, and a conclusion, 

depending on the assignment, a cover or title page, table of contents, and bibliography or works cited page are 

equally important.   

According to Purdue’s Online Writing Lab, “The mechanical elements of your report are largely included to 

make sure your information was useful and accessible as possible for your readers. It is especially important to 

incorporate the HATS methodology (headings, access, typography, spacing) when designing your mechanical 

elements, as that will make your documents easier to read, and it will give your documents a professional 

appearance.” (Cember, Heavilon, Seip, Shi, & Brizee, 2010) 

Title Page  

According to Wikipedia, “The title page of a thesis or essay is the work's first page. It lists the title of the work 

and the name of the author. In the case of an academic paper, the title page also lists class information (such 

as the course name and number), identification information (such as the student number), the date, name of 

the professor, and name of the institution. The title page is not numbered. Title pages are not required in all 

citation styles; instead, some styles require that the same information is placed at the top of the essay's first 

page. The title page for a thesis contains the full title, the author's name and academic credentials, the degree-

granting faculty and department name, the name of the university and date of graduation, and the universal 

copyright symbol” (Wikipedia, 2011) 

Table of Contents 

A table of contents is a list of divisions (chapters or articles) and the pages on which they start.  (WordNet® 

3.0)  The table of contents can also include figures and their page numbers. 

Bibliography 
A bibliography, in this case, or works cited page, a list of source materials that are used or consulted in the 

preparation of a work or that are referred to in the text.  (Dictionary.com Unabridged, 2011) 

Creating the Title Page 
To begin, open Microsoft Word.  You will notice that Word automatically opens a blank page when it starts.  

You will use this page to create your document. 
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Step 1:  Insert Title Page 
Click the “Insert” tab at the top of the application window, then click the “Cover Page” quick link below the 

main menu.  When the cover page choices are shown, pick the style you want for your document.  I chose the 

“conservative” style.  One you click the style of your choice, the cover page is automatically added to your 

document.  See Figure 1: Cover Page below.  The cover page for this tutorial was created using the above 

method.  Once you have inserted a cover page, you can alter its contents. 

 

Figure 1: Cover Page 

Step 2:  Insert a Page Break 
Now that you have created the cover page, you will need to insert a page break.  Doing so will create a new 

page after the cover page and it will automatically place your cursor at the beginning of that page. Click the 

“Insert” tab at the top of the application window if you are not still there from inserting the cover page.  Now, 
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click the “Page Break” quick link.  See Figure 2: Page Break below. You have now added a new page after the 

cover page.   

 

         Figure 2:  Page Break 

Creating the Table of Contents (TOC) 
The TOC should be added to the blank page located after the cover page.   

Step 1: Insert the Table of Contents  

To add the TOC, click on the “References” tab at the top of the application window and then click the “Table of 

Contents” quick link.  You will notice that you are given different format styles for your table of contents.  I 

suggest choosing one of the first two “automatic” styles.  The “automatic” styles can be updated with a click of 

the mouse.  I will explain this feature later.  For now, you just want to get the TOC inserted.  See Figure 3: Table 

of Contents below. 

 

Figure 3: Table of Contents 

 

Once you have made your choice, click it so that the TOC is inserted.  Figure 4: Table of Contents below shows 

how your inserted TOC should look like. 
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Figure 4: Table of Contents 

 

Now that you have inserted your table of contents, repeat the step for inserting a page break so that a new 

blank page is added to your document after the table of contents page.  This new blank page is where you will 

start the body contents of your document.  As you can see, this tutorial’s body content is separated into 

sections that include headings.  The headings that you include within the body content of your document are 

what the automatic table of contents uses to create its list.  For example, to format this particular section, I 

used the heading 1 style for the heading “Creating the Table of Contents (TOC)”, heading 2 style for “Step 1: 

Inserting the Table of Contents”, and I added captions to the images located in this section and used the 

heading 3 style to format them.  When I update my automatic TOC, it will include all of these areas according 

to their position within this document.  So let’s see how this works. 

Step 2: Updating the Table of Contents 
You can update the TOC as many times necessary while working on your document.  To update the TOC to 

include all document sections added, scroll to where the TOC is located within your document.  Once there, 

use your mouse to click the TOC anywhere near the “Table of Contents” heading.  After doing this, you will 

notice that the TOC is highlighted and includes a tab above it that is titled “Update Table.”  See Figure 5: Table 

of Contents below 

 

Figure 5: Table of Contents 

 

When you click on that tab, a dialog box appears asking if you want to update the page numbers only or 

update the entire table.  I suggest updating the entire table.  See Figure 6: Table of Contents below.  
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      Figure 6: Table of Contents 

 

Once your choice is made, click “OK”.    Your TOC should now include all headings and image captions that you 

have included in your document so far.  See Figure 7: Table of Contents below to view my updated TOC for this 

document. 

 

Figure 7: Table of Contents 
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Creating the Bibliography 
Creating the bibliography or works cited page involves a few more steps, but is just as easy as creating the 

table of contents and it has the ability of being automatically updated as well.  What is really nice about 

Word’s bibliography feature is that you can format its contents according to the style of your choice.  The 

different styles available will be shown in this tutorial later. 

Step 1: Inserting the Bibliography or Works Cited Page 
The bibliography or works cited should be the last page of your document.  Before inserting it you may need to 

go through the steps of inserting a page break first.  Once you have created the page break, you should have 

an ending blank page.  With your cursor located at the beginning of this page, click the “Reference” tab located 

at the top of the application window.  Now click the down arrow next to the style option located in the 

“Citations & Bibliography” section of the quick links.  You will now see a list of style options for your 

bibliography or works cited page.  See Figure 8: Bibliography below. 

 

Figure 8: Bibliography 

 

Once you have chosen the style for your bibliography or works cited format, it is now time to insert it.  To do 

so, click on the “Bibliography” down arrow, located below the “Style” option you used to format your 

bibliography.  This will reveal the bibliography layout choices.  Once the choices are revealed, either double-

click the layout of your choice to insert the bibliography or highlight your choice and click the "Insert 

Bibliography" link below the choices.  .See Figure 9: Bibliography below. 
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Figure 9: Bibliography 

 

Your inserted bibliography should look like Figure 10: Bibliography below.  Notice how it resembles a newly 

inserted table of contents?  Updated the bibliography is done in the same way you would update the table of 

contents.  However, while the table of contents is updated according to section headings, the bibliography is 

updated according to citations. 

 

            Figure 10: Bibliography 

Step 2:  Inserting Citations 
In my introduction section of this tutorial I have included definitions I obtained from different resources on the 

Internet for title page, table of contents, and bibliography.  Because I obtained these definitions from outside 

resources, I must cite them.  To do this, I need to add a citation to the end of each definition.  You will have to 

do when citing different information throughout your project.  To insert your citation, go to the end of the 

paragraph you want to cite and click on “Insert Citation” located under the “References” tab, and click “Add 

New Source.”  See Figure 11:  Insert Citation below. 
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           Figure 11: Insert Citation 

 

After clicking “Add New Source,” a dialog box will appear.  Use this dialog box to add all the appropriate 

information about the source you are citing such as type, author, and date accessed, and so on. Ticking the 

“Show All Bibliography Fields” check box will open more options. See Figure 12: Insert Citation below. 

 

Figure 12: Insert Citation 

 

Once you have included all information needed for the source, click the “OK” button at the bottom of the 

dialog box.  You will notice that the citation you just created was automatically added to the end of your 

paragraph, enclosed in parentheses.  See Figure 13: Inset Citation below.  Also, now that you have added this 

citation, you can use it in other places throughout your document without having to re-create it. 



10 
 

 

Figure 13: Insert Citation 

 

Step 3: Updating the Bibliography or Works Cited Page 
Now that you have added a citation, you can update your bibliography or works cited page in the same way 

that you updated the table of contents.  To do this, scroll to your bibliography page and use your mouse to 

click near the “Bibliography” or “Works Cited” heading.  When the “Update Citations and Bibliography” tab 

appears, click it.  Notice that your bibliography page automatically added the citation you created earlier and 

in the correct style format that you chose when setting up the bibliography in the first place.  In my case, the 

style I chose was the APA Sixth Edition format.  See Figure 14: Updating the Bibliography below. 

 

Figure 14: Updating the Bibliography 

Inserting Page Numbers 
Once you have completed your project, it is a good idea to insert page numbers.  Especially since your 

document includes a table of contents.  Also keep in mind that most professional documents do not include a 
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page number on the cover or title page.  Because you used the “Insert Cover Page” feature, a page number will 

not be added to the cover page when you insert page numbers. 

Step 1: Insert Page Numbers 
To insert page numbers on all pages except the cover page, click the “Insert” tab at the top of the application 

window.  Now click the “Page Number” quick link to reveal the page number options.  Clicking on your choice 

of page number position will add the page numbers to your entire document other than the cover page.  See 

Figure 15: Inserting Page Numbers below.  

 

 

Figure 15: Inserting Page Numbers 

Conclusion 
After completing the tasks explained in this tutorial, you should have a good idea how to use these very helpful 

features available in Microsoft Word version 2007 and 2010.  I am certain that after completing this tutorial 

you will be on your way to creating great research papers, book reports, term papers, and the like. 
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